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Overview
This document explains how to install or upgrade the Oracle Workflow and Oracle XML 
Gateway components that reside on a client PC. This document applies to the Oracle 
Workflow and Oracle XML Gateway client components available with Oracle E-Business 
Suite.

Oracle Workflow and Oracle XML Gateway contain several client components that are 
installed using the Oracle Universal Installer from the Start Here disk:

• Oracle Workflow Builder for Microsoft Windows XP

• Oracle Workflow Common Files

• Oracle Workflow HTML help

• Oracle XML Gateway Message Designer for Microsoft Windows 2000

• Oracle XML Gateway Message Designer HTML help

The Oracle Universal Installer and this installation guide are included on the Start Here disk. 
The disk includes the following directory structure and files when viewed from a PC with 
access to a DVD-ROM drive: 

• Oracle Universal Installer - 
<drive_letter>:\WFEMB\wfclnt26\install\win32\setup.exe

• Installation Guide - <drive_letter>:\WFEMB\wfclnt26\wfinstcl.pdf, 
<drive_letter>:\WFEMB\wfclnt26\wfinstcl\toc.htm

Oracle Workflow Builder and Oracle XML Gateway Message Designer 
Hardware and Software Requirements

Oracle Workflow Builder and Oracle XML Gateway Message Designer must be installed into 
an Oracle9i Release 2 (9.2) client Oracle Home directory. They require the following hardware
and software configurations.
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Oracle Workflow Builder
Oracle Workflow Builder is a GUI tool that allows you to create and edit workflow definitions
on a PC running Microsoft Windows XP. A workflow definition can be saved to a flat file or 
to your Oracle E-Business Suite database if you have Oracle Net installed on your PC. Oracle 
Workflow Builder requires the following hardware and software configurations:

• Oracle Net Client Version 9.2.0.1 or higher (included in the Oracle Workflow Builder 
installation)

• Required Support Files Version 9.2.0.1 or higher (included in the Oracle Workflow 
Builder installation)

• An IBM, Compaq, or 100% compatible personal computer with the following:

• A 486 processor or better

• Clock speed of 66 Mhz or greater (90 Mhz or greater is recommended)

• Network card

• SVGA color monitor

• Remote access for use by Oracle Worldwide Customer Support. At least one PC at 
your site should be configured with remote access.

• DVD-ROM available as a logical drive

• Microsoft Windows XP

Note: For installing on Microsoft Windows Vista, please refer to the 
Known Issues, page 6.

• At least 65 Mb of available disk space to install Oracle Workflow Builder, Oracle Net, 
and Required Support Files

• At least 32 Mb of memory, 64 Mb recommended

• Users must have Administrator privileges to run Oracle Workflow Builder

Note: The Oracle TCP/IP Protocol Adapter requires and only supports the use
of Microsoft's TCP/IP drivers.

Note: Oracle Workflow Builder currently cannot be installed on a central file 
server or be shared by other client PCs over the network.
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Oracle XML Gateway Message Designer
Oracle XML Gateway Message Designer is a wizard-guided, GUI-oriented, repository-based 
tool that allows you to create XML message maps on a PC running Microsoft Windows 2000. 
Oracle XML Gateway Message Designer requires the following:

• Either JDK 1.1.8 or JRE 1.1.8 or higher. JRE 1.1.8 is included in the Message Designer 
installation.

• At least 15 Mb of available disk space to install Oracle XML Gateway Message Designer, 
HTML help, and JRE 1.1.8.

Oracle Workflow Builder and Oracle XML Gateway Message Designer 
Installation Steps

Perform the following steps to install the Oracle Workflow Builder or Oracle XML Gateway 
Message Designer on a PC.

Note: Any variable input in the following commands is enclosed in brackets 
and is italicized. Replace these variables with the appropriate information 
specific to your environment.

Step 1. Install Oracle Workflow Builder or Oracle XML Gateway Message 
Designer using the Oracle Universal Installer:
1. Insert the Start Here disk in the DVD-ROM drive of your PC. Choose Run from the 

taskbar Start button and enter the following command to run the Oracle Universal 
Installer:
<drive_letter>:\WFEMB\wfclnt26\install\win32\setup.exe

2. When the Oracle Universal Installer is started, the Welcome window appears. Click Next.

Note: Click Help in any Oracle Universal Installer window for more 
information about that window.

3. The File Locations window appears. Review the stage location of the Oracle Workflow 
Builder and Oracle XML Gateway Message Designer files, and enter the Oracle Home 
location where you want to install client components. Then click Next.

4. The Available Products window appears. Select whether you want to install Oracle 
Workflow Builder or Oracle XML Gateway Message Designer . Then click Next.

Note: When you install Oracle Workflow Builder, the Oracle Workflow 



4

Common Files and the Oracle Workflow HTML help are automatically 
installed as well.

When you install Oracle XML Gateway Message Designer, its HTML help
is automatically installed as well. 

5. If you are installing Oracle Workflow components and you are installing Java Runtime 
Environment for the first time, the Component Locations window appears. Enter the 
destination location where you want to install Java Runtime Environment. Then click 
Next.

6. The Summary window appears. Review the summary information to ensure you have 
enough disk space. When you are ready to begin the installation, click Install.

7. The Install window appears, displaying the progress of the installation.

8. If you are installing Oracle Workflow components and you are installing Oracle Net 
Client for the first time, the Configuration Tools window appears when the installation is 
complete, and the Oracle Net Configuration Assistant automatically starts.

In the Oracle Net Configuration Assistant window, select a method by which to configure
client access to your Oracle database. The Oracle Net Configuration Assistant helps you 
configure your client access.

Note: Refer to the Oracle9i Client Installation Guide for more information 
about running the Oracle Net Configuration Assistant.

9. The End of Installation window appears. Click Exit to exit the Oracle Universal Installer. 
You can also click Next Install to return to the File Locations window and install another 
component.

Step 2. Set up the Oracle Workflow HTML help (optional):
When you install Oracle Workflow Builder, the Oracle Universal Installer copies a zip file 
containing the HTML help to the Oracle Workflow directory in your Oracle Home. The zip 
file is <ORACLE_HOME>\wf\wfdoc.zip. Before you can view the HTML help, you must 
extract the doc directory tree from the zip file to your file system.

1. Use an unzip utility to extract the doc directory tree from the zip file within the Workflow
directory. You need at least 7 Mb of free disk space to extract the zip file.

The doc directory tree that is created includes the Oracle Workflow documentation area, 
<ORACLE_HOME>\wf\doc, and the following subdirectories:

• <ORACLE_HOME>\wf\doc\<lang>\wf - Oracle Workflow online help. 

• <ORACLE_HOME>\wf\doc\<lang>\wfcust - Custom help. You can optionally add 
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your own customized Workflow help in this directory.

Note: You can also install the doc directory tree in a directory that you 
choose on your PC file system. Create a directory for the HTML help. 
Then transfer the HTML help zip file, wfdoc.zip, from the Workflow 
subdirectory within your Oracle Home to the new directory. Use an 
unzip utility to extract the doc directory tree from the zip file in that 
directory.

2. After extracting the doc directory tree, you can optionally remove the zip file.

3. You can now view the HTML help using a Web browser. 

The path for the contents page of the Oracle Workflow documentation is:
\<ORACLE_HOME>\wf\doc\<lang>\wf\toc.htm

The path for the contents page of your Oracle Workflow custom help is:
\<ORACLE_HOME>\wf\doc\<lang>\wfcust\wfcust.htm

You can also view context-sensitive help for Oracle Workflow Builder in Winhelp format 
by choosing Contents from the Help menu within Oracle Workflow Builder.

4. If you want to add custom help, you can replace the placeholder file in the wfcust 
directory, wfcust.htm, with your own help material. The HTM file that is the main entry
point for your custom help must be named wfcust.htm and must contain an anchor 
named contents. Your custom help will be accessible through the Custom Help link on 
the contents page of the Oracle Workflow online help.

Step 3. Modify fonts in Oracle Workflow Builder (optional):
If you are installing Oracle Workflow Builder in another language such as Japanese, you can 
modify the font used by the windows in Oracle Workflow Builder to a font that is appropriate
for your language. Any change you make applies to all windows within the program.

1. Choose Font from the View menu to display the Fonts properties page.

2. Choose Font from the View menu to display the Fonts properties page.

3. Select the font style: Regular, Bold, Italic, or Bold Italic. Some fonts have a limited 
selection of font styles.

4. Select the font size to use. Some fonts have a limited selection of font sizes.

5. Select the Underline or Strikeout check boxes to apply those effects.

6. Choose OK when you are finished.

7. Close and restart Oracle Workflow Builder. The new font settings should then take effect.
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Step 4. View the Oracle XML Gateway Message Designer HTML help (optional):
When you install Oracle XML Gateway Message Designer, the Oracle Universal Installer 
automatically installs the Message Designer HTML help as well. The HTML help is located in 
the ecx\help subdirectory within your Oracle Home. You can view the help by choosing 
Help Topics from the Help menu within Oracle XML Gateway Message Designer, or you can 
access the help directly using a Web browser. The path for the contents page of the Message 
Designer help is:
\<ORACLE_HOME>\ecx\help\ecxmdtoc.htm

Known Issues
This section lists known issues for the Oracle Workflow Builder installation and possible 
workarounds for those issues.

• In some cases you may see the following error message during the installation: "Error 
encountered when registering <filename>, please run regsvr32.exe 
manually to register this file after the installation completes." 
For example, you may see this error for the wfnvg.ocx file.

If you encounter this error, close the error message and proceed with the installation. 
After the installation is complete, register the specified file manually by running the 
following command from a DOS prompt:
regsvr32 <path>\<filename>

Replace <path> with the path to the file and <filename> with the name of the file to 
register. The wfnvg.ocx file is normally located in the <ORACLE_HOME>\bin directory.

• If you choose to install Oracle Workflow Builder on Microsoft Windows Vista, the setup 
program may fail with the following error: "OUI cannot determine the platform
of this system. This may occur if OUI is running on a system that 
is not supported or there is a bug in OUI. Please confirm that the
system is a supported configuration; and if it is supported, then 
please contact Oracle Support."

After this error, stop the installer and simply rerun the setup program, and the 
installation should proceed.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle 
Support at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues 
and provide customer support according to the Oracle service request process. Information 
about TRS is available at http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html. 
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible to all 
users, including users that are disabled. To that end, our documentation includes features that
make information available to users of assistive technology. This documentation is available 
in HTML format, and contains markup to facilitate access by the disabled community. 
Accessibility standards will continue to evolve over time, and Oracle is actively engaged with 
other market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For more information, visit the 
Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/. 

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty
line; however, some screen readers may not always read a line of text that consists solely of a 
bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations that 
Oracle does not own or control. Oracle neither evaluates nor makes any representations 
regarding the accessibility of these Web sites. 

Legal Notices
This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish 
or display any part, in any form, or by any means. Reverse engineering, disassembly, or 
decompilation of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to 
be error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone 
licensing it on behalf of the U.S. Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS
Programs, software, databases, and related documentation and technical data delivered to 
U.S. Government customers are "commercial computer software" or "commercial technical 
data" pursuant to the applicable Federal Acquisition Regulation and agency-specific 
supplemental regulations. As such, the use, duplication, disclosure, modification, and 
adaptation shall be subject to the restrictions and license terms set forth in the applicable 
Government contract, and, to the extent applicable by the terms of the Government contract, 
the additional rights set forth in FAR 52.227-19, Commercial Computer Software License 
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(December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065. 

This software is developed for general use in a variety of information management 
applications. It is not developed or intended for use in any inherently dangerous applications,
including applications which may create a risk of personal injury. If you use this software in 
dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup,
redundancy and other measures to ensure the safe use of this software. Oracle Corporation 
and its affiliates disclaim any liability for any damages caused by use of this software in 
dangerous applications. 

This software and documentation may provide access to or information on content, products 
and services from third parties. Oracle Corporation and its affiliates are not responsible for 
and expressly disclaim all warranties of any kind with respect to third party content, products
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or
damages incurred due to your access to or use of third party content, products or services. 
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